
Learn  This:  Use  Autocorrect
in  Microsoft  Outlook,  Word
and  Excel  to  Fix  Your  Own
Common Typos

Becoming  more  productive  is  almost  a
lifestyle for some people.

With everyone running around trying to get more done in less
time, the allure of increased efficiency drives a lot of the
decision  making  of  professionals,  providers  and  patients
alike. One area that is easy to overlook however is learning
to use all of the capabilities of the tools you already have.
Take software for instance: maximizing efficiency means making
sure you (and your employees) are getting the most bang for
your  practice’s  buck  out  of  the  software  packages  they
purchase. Learn to really use the stuff you have before you
request your next upgrade quote.

The other day a friend of mine asked me a question in a tone
of voice that gave the impression the subject had been a
persistent pain in her neck.

“Is there a way to get a to get Word to recognize that I type
“anyhting” by accident every time I mean to type “anything”? I
must do it twenty times a day, and having to stop and correct
it is really slowing me down”

 

Say what you will about the Microsoft Office products that are
commonly  found  in  business  settings  –  they  don’t  lack  in
features. In this case my friend had a feeling that Microsoft
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had  something  like  its  Autocorrect  feature  for  your  own
“personal typos”.  Autocorrect is the handy feature that will
turn common typos-  “teh” instead of “the” etc… – into what
Microsoft assumes is what you meant to say. Autocorrect-like
software is also found on most cellphones’ text messaging
programs, sometimes to humorous results when the cellphone
makes  bad  assumptions  for  you!  But  can  you  add  your  own
entries to Autocorrect so that your own “anyhting”s can be
taken care of instantly without effort? Yes you can!

The AutoCorrect list is global across the Office programs that
support this feature, which means that when you add or delete
a word from the list in one Microsoft Office program, the
other Office programs are also affected.

Create  or  Change  AutoCorrect
entries in Microsoft Office 2010

Click the File tab and then, under Help, click Options.1.
If you are using Outlook 2010, click Mail and then click2.
Spelling and AutoCorrect…For all other programs, go to
step 3.
Click Proofing.3.
Click AutoCorrect Options.4.
On the AutoCorrect tab, make sure the Replace text as5.
you type check box is selected.
In the Replace box, type a word or phrase that you often6.
mistype or misspell — for example, type usualy.
In the With box, type the correct spelling of the word —7.
for example, type usually.
Click Add.8.
Click OK.9.

Create  or  Change  AutoCorrect



entries in Microsoft Office 2007

In Outlook
On the Tools menu, click Options.1.
Click  the  Mail  Format  tab,  and  then  click  Editor2.
Options.
Click Proofing, and then click AutoCorrect Options.3.
On the AutoCorrect tab, make sure the Replace text as4.
you type check box is selected.
In the Replace box, type a word or phrase that you often5.
mistype or misspell — for example, type usualy.
In the With box, type the correct spelling of the word —6.
for example, type usually.
Click Add.7.

In Word
Optionally, if you want to add a formatted text entry,1.
open  the  document  that  contains  the  text  that  is
formatted the way that you want, and select that text.
Click the Microsoft Office Button, and then click Word2.
Options at the bottom of the window.
Click Proofing.3.
Click AutoCorrect Options.4.
On the AutoCorrect tab, make sure the Replace text as5.
you type check box is selected.
In the Replace box, type a word or phrase that you often6.
mistype or misspell — for example, type usualy.
In the With box, type the correct spelling of the word —7.
for example, type usually.
Click Add.8.

Create  or  Change  AutoCorrect



entries in Microsoft Office 2003

In Outlook

From the main Microsoft Outlook window, on the Tools1.
menu, click Options, and then click the Spelling tab.
Click AutoCorrect Options.2.
In the Replace box, type a word or phrase that you often3.
mistype or misspell — for example, type usualy.
In the With box, type the correct spelling of the word —4.
for example, type usually.
Click Add.5.

In Word

On the Tools menu, click AutoCorrect Options.1.
In the Replace box, type a word or phrase that you often2.
mistype or misspell — for example, type usualy.
In the With box, type the correct spelling of the word —3.
for example, type usually.
Click Add.4.

What are some of your favorite little known software tips and
tricks? Share in the comments below.

 

Learn  This:  File  Extensions
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and the Generation Gap
People  of  my  generation  (the  author  is  in  the  late
afternoon of his twenties) don’t get it.  What we don’t get

is how relatively new and modern personal computing technology
is.   We  don’t  realize  that  we  were  one  of  the  first
generations  to  have  computers  in  our  classrooms  when  we
started kindergarten, one of the first to have internet access
in our libraries, and one of the first to have networked
computer interaction as a fundamental part of our lives from a
young age.  We don’t understand why other generations don’t
find computing as intuitive as we do.

Learning  to  use  computers  effectively  is  a  process  of
repetition, immersion, and is ideally started early in life,
just like learning a new language.  I think there is both a
challenge and an opportunity – for all generations – in the
generational computing gap.  The younger folks who can find
ways to tailor their products and services towards usability,
approachability and friendliness can often make big strides in
taking new technologies mainstream.  Boomers and older have
tremendous  opportunities  to  separate  themselves  from  their
peers and their competitors by balancing a willingness to be
open minded about embracing technology with a keen eye towards
results.

In this spirit I would like to talk about a basic computing
concept: file extensions.  First, what is a computer file?

A file is a block of information which can be used in
conjunction with a computer program.  A file is durable in
the sense that it remains available for programs to use after
the current program has finished.  Computer files are the
modern counterpart of paper documents which traditionally
were kept in office files, which is the source of the term.

Every  word  processing  document,  spreadsheet,  Microsoft
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PowerPoint presentation, MP3, and video on your computer is
housed in its own “file”.  A program can use these files to
achieve results, such as reading or editing a word processing
document, using a spreadsheet to record and predict figures,
showing a presentation at a meeting or conference, or to play
a song or movie.

Each of these files has a name, and that file name usually has
two parts. The actual name of the file, and then, after a
period, or dot, a file extension.

For  example,  if  you  open  your  Microsoft  Windows  Notepad
program in the acessories section of the start menu, click on
the  “File”  menu,  and  then  click  “Save”,  you’ll  will  be
prompted  to  enter  a  name  for  the  file,  which  is  called
“Untitled” until you name it. But you can also see that the
file will be saved with the extension “.txt”.  If you choose
to name the file “agenda”, the official name of the file will
be  “agenda.txt”.   In  newer  operating  systems,  you  rarely
actually see the file extension on the screen.  In Windows XP
and  Vista,  you  will  see  the  file  represented  simply  as
“agenda” with a small icon next to it that looks like a sheet
of paper from a small notepad – the symbol for the “Microsoft
Notepad” program.

File extensions are less visible these days, but knowing how
to interpret them can still pay big dividends.  The file
extension serves to give the computer and its operating system
a sense of how to handle the file.  By putting “.txt” after
“agenda”  in  our  Notepad  document,  we  are  notifying  the
computer what we intend to use the file for, which programs we
want to use it with, and in general, what to expect when that
file is opened. It’s no different than labeling a physical
file in a physical filing cabinet. If all your invoices are in
red files, you don’t have to look through the blue ones when
searching for one.

File extensions are helpful in the same way to the user.  When



we are emailed a file, or trying to download one, the file
name and the file extension are important clues as to what the
file  contains.  If  my  CPA  emails  me  a  Microsoft  Excel
spreadsheet file, I’ll know to look for the “.xls” extension. 
If my lawyer sends me a contract, it very likely will come
with the extension “.doc” for a Microsoft Word Document.  On
the other hand, if someone says they are sending me a picture
of a waterfall, and the program has a strange extension for an
image, like “.dll” or “.exe”, than I know I’m going to want to
be sure this is something I can trust. From here, the only
thing to really learn is what the different file extensions
are.

Common Microsoft Office / Document files

File
Extension

Description Associated
Program

What is it?

.doc Document file
with text
formatting,

often used with
software’s

“doc”umentation.

Microsoft
Word,

Microsoft
Wordpad

Text file
with

formatted
text.

.docx Microsoft Office
2007 OpenOffice
format (without

macro
extensions)

Microsoft
Word 2007

Microsoft
Word 2007
(standard)

.docm Microsoft Office
2007 OpenOffice
format (with

macro
extensions)

Microsoft
Word 2007

Microsoft
Word 2007

(with macro
extensions)



.pdf Adobe “Portable
Document Format”

Adobe Reader
(to view),

Adobe
Acrobat (to
create and

edit)

A rich text
file with
extensive

formatting.
Often used
to scan in
complicated
forms, or
create

portable,
polished
documents

.ppt Microsoft
Powerpoint
Standalone
Slideshow

None- the
program can
be run by
itself, so
you don’t

need to have
Powerpoint
on the
computer
you’re

presenting
on

Microsoft
Powerpoint
Presentation

.pptx Microsot
Powerpoint 2007

OpenOffice
Extension

Microsoft
Powerpoint

2007

Microsoft
Powerpoint
Presentation

.pps Microsoft
Powerpoint
Slideshow

Microsoft
Powerpoint

Microsoft
Powerpoint
Presentation

.xls Microsoft Excel
Spreadsheet

Microsoft
Excel

Spreadsheet



.xlsx Microsoft Excel
2007 OpenOffice

Spreadsheet

Microsoft
Excel 2007

Spreadsheet

Common Multimedia Files

File
Extension

File Extension Associated
Program

What is
it?

.asf “Advanced
Streaming
Format” –
compressed
Windows

audio/visual
file

Windows Media
Player

An audio
or video
streamed
online

.avi “Audio/Video
Interleaved”
animation file

Windows Media
Player, most
any video
playing
software

Video
file

.gif “Graphics
Interchange
Format”

Web Browser, or
photo editing /

viewing
software

Picture
File

.jpeg “Joint
Photography

Experts Group”
image format

Web Browser, or
photo editing /

viewing
software

Picture
File

.jpg “Joint
Photography

Experts Group”
image format

Web Browser, or
photo editing/

viewing
software

Picture
File

.mov Apple Quicktime
Movie File

Apple
Quicktime,

other available
video software

Video
File



.mpeg “Moving Picture
Experts Group”
video format

Windows Media
Player, most
any video
playing
software

Video
File

,mpg “Moving Picture
Experts Group
video format

Windows Media
Player, most
any video
playing
software

Video
File

Other Common File Types

File
Extension

Description Associated
Program

What is it?

.exe An
EXEcutable
program

file. When
opened, this

file
launches a
program. Be
careful!
Most all
programs

will start
with an

.exe, good
or bad

None, it is
the program

A piece of
software



.faq A
“Frequently

Asked
Questions”
text file,

often
bundled with
software to

answer
common

questions

Any text
editor

Something
good to read
before you
get started

.rar “Roshal
Archive”

compression
file

WinRar A
“compressed”
file is a
large file

made smaller
to send over
a network.
The files

are
compressed

and
decompressed

in a
separate
program
(WinRar)

.txt Basic text
file

Any text
editor

The most
simple form
of word

processing
document



.zip ZIP
“compression

file”

PKUnzip, many
other

available
decompression

programs

A
“compressed”
file is a
large file

made smaller
to send over
a network.
The files

are
compressed

and
decompressed

in a
separate
program


